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Никакая часть этой публикации или сопровождающего программного обеспечения не подлежит 
репродуцированию или распространению, передаче, транскрибированию, сохранению в поисковой 
системе или переводу на любой естественный или машинный язык в любой форме или любыми 
средствами: электронными, механическими, магнитными, ручными или другими, или передана для 
использования любому третьему лицу без специального письменного разрешения: 
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Примечание 
Экранные иллюстрации в этой публикации дают лишь примерное представление и не являются 
точными копиями экранных изображений, воспроизводимых программным обеспечением. 
Напечатанная инструкция пользователя 
Зарегистрированным владельцам ПО BERNINA Embroidery Software разрешается распечатать 1 
(одну) копию Инструкции пользователя ПО BERNINA Embroidery Software для личного пользования. 
Копия может быть распечатана на собственном принтере или в копировальном магазине. 
Ограниченная Гарантия 
Фирма BERNINA International AG гарантирует, что в течение 90 дней с даты приобретения Вами 
программного обеспечения программные продукты не содержат дефектов по материалам и качеству 
исполнения. Вам предоставляется исключительное право в случае обнаружения таких дефектов 
возвратить изделия вместе с доказательством покупки фирме BERNINA или уполномоченным 
торговым агентам в течение гарантийного срока для безвозмездной замены. Вы оплачиваете 
стоимость пересылки и страховки  и несете риск в случае повреждения и ошибочной адресации 
"продуктов ". 
Покупатель полагается на свое собственное умение и знание при выборе программного обеспечения 
для собственного использования и принимает весь риск относительно результатов применения 
программного обеспечения. В соответствии с правовыми условиями гарантии фирма BERNINA 
International AG не принимает на себя все другие гарантии и условия, которые могут быть явно 
выражены или подразумеваемы, включая без ограничения, гарантии и условия пригодности для 
продажи, соответствия для специфического использования и отсутствие контрафакции. Фирма 
BERNINA International AG специально не гарантирует, что программное обеспечение будет 
соответствовать всем требованиям покупателя или будет выполняться без прерываний или ошибок, 
в полном соответствии с описанием в сопровождающей документации. 
Ограничения Ответственности 
Фирма BERNINA International AG, ее разработчики, менеджеры, служащие или работники филиалов 
в соответствии с применимым законом, ни в коем случае не несут ответственности за любые 
последующие прямые или косвенные убытки (включая убытки от потери деловой прибыли, 
перерывов в работе, потери коммерческой информации и т.п.), возникшие в результате 
неправильного использования программного обеспечения или прилагаемых защитного устройства и 
кабеля, а также сопровождающей документации, независимо от обоснования требования и даже, 
если фирма BERNINA или ее уполномоченный представитель уведомлялся относительно 
возможности таких убытков. 
В некоторых государствах законодательство или судебная практика не допускают исключения 
случайных, последующих или специальных убытков, так что вышеупомянутое ограничение или 
исключение не может быть применимо к Вам. 
Прекращение Действия Лицензионного Соглашения  
Ваша Лицензия на использование программного обеспечения фирмы BERNINA действительна до 
тех пор, пока Вы выполняете условия Лицензионного соглашения. Действие Лицензии завершится 
автоматически без уведомления фирмы BERNINA International AG, если Вы будете не в состоянии 
выполнять любое из условий Лицензионного соглашения. Вы можете прекратить действие этой 
Лицензии в любое время,  возвратив программное обеспечение и все его копии этого, аппаратный 
ключ "донгл" (Dongle), кабель и всю сопровождающую документацию фирме BERNINA International 
AG. 
Контактные телефоны 
Если у Вас возникнут любые вопросы, обращайтесь, пожалуйста, Вашему дистрибьютору фирмы 
BERNINA, или BERNINA International AG  
CH-8266 Штекборн/Швейцария 
Тел.: (41) 52-762 11 11 
Факс: (41) 52-762 16 11 
Ред. 1 июня  2013 
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ВВЕДЕНИЕ 
 
 
BERNINA

®
 Embroidery Software – это лучшее 

программное обеспечение для создания вышивок в 
домашних условиях. Она создана на основе MS 
Windows

®
, что позволяет использовать многие функции, с 

которыми пользователи обычных РС уже знакомы.  
BERNINA Embroidery Software интегрировано с ПО 
CorelDRAW

® 
Essentials X6 от компании Corel Corporation, 

которое является самым популярным пакетом программ 
векторной графики среди домашних пользователей. Это 
сочетание позволяет создавать проекты вышивок 
наиболее эффективным и удобным образом, объединяя вышивальные функции BERNINA 
Embroidery Software с графическими функциями CorelDRAW

®
. Оно позволяет пользователям 

создавать не просто вышивки, но и по-настоящему сложные мультимедийные проекты.  
 

Примечание  
CorelDRAW

® 
Essentials X6 и родственный ему программный продукт, Corel PHOTO-PAINT

® 

Essentials X6 можно использовать и как отдельные самостоятельные приложения. Вся 
информация содержится в электронном Руководстве пользователя, которое можно найти в 
системе Windows в меню Start > Programs (Пуск > Программы) Можно найти ее и в системе 
экранной помощи в графическом режиме. 

 
 
 

Начинающим пользователям 
Если вы еще не знакомы с ПО  BERNINA 
Embroidery Software, Вам понравятся ее гибкие 
возможности оцифровки и простота, с которой 
можно создавать графические проекты, 
добавлять и создавать новые шрифты. Тем не 
менее, прежде, чем начать работу с программой, 
прочтите Руководство для начинающего 
пользователя (Getting Started) – см. стр. 4.  
 
Опытным пользователям 
 
BERNINA Embroidery Software – это 
расширенная версия ранее существовавших 
программных продуктов с многими новыми или 
расширенными функциями. Чтобы быстрее 
ознакомиться с этими новшествами, прочтите 
пожалуйста сведения о программе ( Release 
Примечаниеs) в меню экранной помощи Help. 
 
Устройство 
безопасности 
ПО BERNINA 
Embroidery Software 
защищено с 
помощью так 
называемой USB- 
заглушки, которую 
следует подключить к 

компьютеру. Если заглушка не будет обнаружена 
при попытке запустить программу, она не будет 
работать. Каждая заглушка имеет свой серийный 
номер и код.  Заглушка является самой ценной 
яастью системы и обращаться с ней следует с 
осторожностью. Когда не используете, храните 
ее в надежном месте. При правильном 
использовании, заглушка имеет гарантию 
нормальной работы ибез повреждений 
материалов и устройства на 12 месяцев с даты 
поставки. .Однако в случае потери или кражи 
заглушки, Вам придется приобрести весь пакет 
ПО BERNINA Embroidery Software для замены 
системы. На этот случай подумайте отом, чтобы 
застраховать вашу заглушку.. 
 
Установка ПО 
Процедура установки позволяет выбрать:  
 
• Где будет сохранено ПО и образцы проектов  

- на Вашем РС или в сети  
• Какие компоненты будут установлены – 

например, дополнительные языки или 
BERNINA Portfolio  

• Какие файлы с документами будут 
установлены 

 
При обновлении ПО не удаляйте старую версию 
заранее. Установочная программа сделает это 
за вас.   
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Как установить программное обеспечение 
BERNINA  
 
• Закройте все программы Windows на Вашем 

ПК. 
• Ртключите брандмауер и антивирусное ПО, 

чтобы программа и драйверы установились 
корректно 
 

• Вставьте установочный диск DVD BERNINA 
Embroidery Software в ваш DVD – драйв и 
следуйте подсказкам программы. 

• Теперь вам будет предложено вставить в      
порт USB компьютера аппаратный ключ      
(заглушку). 

 
• Если на вашем компьютере уже установлены 

одна или более старых версий ПО BERNINA 
Embroidery Software: 
o Вам будет предложено обновить одну из 

прежних версий. 
o Арсое перезагрузки компьютера прежняя 

версия будет слита с новой. 
Как часть нормального установочного пакета 
установится также программа CorelDRAW® 
Essentials X6. 
 
У Вас теперь возможность перезагрузить 
компьютер.   
На рабочем столе Windows появится 
соответствующий значок, а в меню кнопки Пуск 
группа программ BERNINA Embroidery Software.  
 
Любые изменения, которые вы произвели в 
старой библиотеке BERNINA Quilter, будут 
преобразованы для последней версии. При 
инсталляции будут также сохранены все 
пользовательские образцы или проекты.  
 
Ресурсы и поддержка 
 
Информацию о программе BERNINA Embroidery 
Software и о том, как с рей работать, можно 
получить разными способами. Имеются адреса 
ресурсов, где можно скачать готовые образцы 
вышивок.  
 

 

 
 
Отображаемая на экране документация 
(только на английском языке): 
 
В зависимости от уровня программного 
продукта Вы получите следующую 
документацию в полном наборе или только 
часть ее:  
 
Сведения о версии продукта  
 
Сведения о версии продукта входят в комплект 
установочного пакета. Они содержат 
информацию о новых и измененных функциях со 
ссылками на соответствующие разделы 
настоящего Руководства.  
 
Руководство по работе с программами 
 
Руководство содержит подробные сведения по 
всем функциям ПО BERNINA Embroidery 
Software ‘Embroidery Canvas’. Приведены 
пошаговые инструкции действий, образцы, виды 
экранов. Программные приложения BERNINA 
Cross Stitch и BERNINA Quilter описаны в 
отдельных Руководствах. 
 

 Примечание Полное описание 
инструментария CorelDRAW

®
 , входящего в 

состав Artwork Canvas, можно найти в 
электронном Руководстве через меню Windows 
Start > Programs (Пуск > Программы) 
Можно найти ее и в системе экранной 
помощи в графическом режиме.  
 
Система экранной помощи 
Система Нelp позволяет быстро получить 
информацию о программе и советы, что делать в 
или или ином случае. Доступ к контекстной 
помощи с помощью клавиши <F1> .  

 
Дополнительные руководства пользователя 
 
В установочный пакет BERNINA Embroidery 
Software входят дополнительные руководства:  
 
• BERNINA Cross Stitch: , где описаны 

возможности программы BERNINA Cross 
Stitch  

 
• BERNINA Quilter: описывает возможности 

специальной программы BERNINA Quilter.  

Линки к онлайн- 
новой документации 
 
 
Линки к студиям 
проектов вышивок 
BERNINA и OESD   
 
Заказ и установка 
обновлений 
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Он-лайновые ресурсы 
 
В сети многие ресурсы предлагают готовые 
образцы вышивок. Программа BERNINA 
Embroidery Software направит Вас к двум 
богатым ресурсам – студиям вышивального 
дизайна BERNINA и OESD.  
 
Обновление ПО 
Вы можете обновить ваше ПО BERNINA 
Embroidery Software напрямую с помощью меню 
Help, как показано выше. В письмах или устных 
перегоаорах вам придется сослаться на  номер 
заглушки (Dongle Number). Может также 
потребоваться сослаться на  мее серийный 
номер и код идентичности. Эта информация 
указана на самой заглушке.  

 
Ту же информацию можно найти в разделе 
Security Device Options через меню Settings 
(настройки). 
 
Обновления в режиме он-лайн можно найти 
через команды  Purchase Upgrades on the 
Internet в меню помощи Help. Вэб-сайт 
предложит вам выбор из нескольких 
обновлений, подходящих под уровень вашей 
заглушки. Если она соответствует уровню  
BERNINA EditorPlus, сайт предложит обновления 
для уровня BERNINA DesignerPlus. 
 
Предупреждение: Если в настройках браузера 
указан высокий уровень безопасности, загрузка 
ПО может оказаться не возможной. При 
возникновении этой проблемы попробуйте 
установить средний уровень безопасности.
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ПРИСТУПАЯ К РАБОТЕ 
 

Если Вы впервые пользуетесь ПО BERNINA Embroidery 
Software или самой машиной, Вы, вероятно, спросите  ‘С 
чего же начать? 
 
Можно с уверенностью сказать, что Вы проведете много 
часов, изучая как выжать максимум из машины и 
поддерживаемого ею ПО BERNINA. Они работают в 
тесной связке, и потребуется терпение и практика, чтобы 
овладеть созданием и производством вышивки.  
 
Но тем ценнее результат. С каждым  
созданным образцом Вы получаете  
опыт, уверенность и готовность к  
решению новых задач.  
 
 
Начиная работу 
Чтобы начать работу с ПО BERNINA Embroidery 
Software, не требуется никакого опыта. Вы 
можете просто открыть образец и послать его на 
машину для вышивки. Лучше всего начать 
именно здесь. По мере работы Вы научитесь 
‘читать’ образцы и распознавать, какие из них 
подходят, а какие могут вызвать сложности.  
 
Примеры образцов и картинок 
ПО BERNINA Embroidery Software содержит 
сотни готовых образцов, включая множество 
прекрасных орнаментов, примеров и фонов. 
Файлы образцов (в формате ART) и рисунков (в 
форматах BMP, JPG, и WMF) находятся в папке 
My Designs - Embroidery Software 7 (Мои 
образцы). Главное при начале работы – на 
жалеть времени на изучение образцов и 
понимание того, какие именно имеются в 
наличии. 

 
 
 
Прим.: ПО BERNINA Embroidery Software 
содержит приложение BERNINA Portfolio design 
management (управление портфолио) для 

просмотра и управления проектами вышивок. 
Кроме того, изучить  
папки проектов можно при помощи MS Windows

®

 
Explorer.  
 
Другие источники  
Существует множество иных источников, где Вы 
можете приобрести готовые образцы, которые 
можно адаптировать и применить. ПО BERNINA 
Embroidery Software автоматически направит Вас 
к двум из основных – BERNINA и OESD студии 
вышивок.  

Клипарт 
CorelDRAW

® 
Essentials X6 укомплектован 

набором клипартов, которые могут быть 
доступны в группе программ.  

Убедитесь, что Вы знаете образцы клипартов. 
Многие из них могут быть использованы как с 

Доступ к BERNINA и 
OESD студиям  

 

 
Доступ к CorelDRAW® clipart folders  
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проектами вышивок, так и с фонами или 
преобразованы напрямую.  
 
 

  
Возможно удобнее будет скопировать исходную 
папку CorelDRAW

® 
Essentials X6 Clipart в My 

Designs - Embroidery Software 7 (мои 
проекты).  
 
Внимание!  Встроенные клипарты и образцы 
вышивок предназначены только для личного 
использования – т.е. они не могут быть 
использованы для коммерческих целей.  
 
Правила хорошей вышивки 
 
Смотря на проект вышивки (встроенные или 
собственный) проверьте:  
• Швы аккуратные, гладкие и ровные  
• Формы, цвета и баланс  
• Формы залиты правильной заливкой,     

наличие контурных стежков  
• Направление швов соответствует формам  
• Формы прошиты полностью – нет 

нежелательных пробелов  
• Четко видны все детали  
• Буквы четкие и легко читаются. 
 
Конечная вышивка должна обладать 
следующими характеристиками:  
• Проект легко вышивается машиной  
• Ткань не зборит у швов  
• Нет свободных концов. 
 
Высокое качество вышивки начинается с 
хорошего проекта. Затем нужна качественная 
машина для вышивки. Но и этого не достаточно, 
если Вы используете правильную ткань, нити,  
подкладку, натяжение нити и т.д.. Изучите 
руководство к машине и другие вышивки, чтобы 
не ошибиться. 
 
Выбрать и вышить готовый 
проект  
 
Во многих случаях достаточно взять готовый 
проект и вышить его. Многие с этого и начнут. 
Когда Вы выберите проект, нужно будет 
посмотреть, как он будет выглядеть на ткани. 

Для этого нужно осуществить несколько 
действий:  
 
Вышить проект  
 
• Откройте проект в ПО BERNINA Embroidery 

Software.  

 
 
 
• Настройте параметры просмотра по 

желанию.  
 

 
• Проверьте тип ткани и установите нужный 

через меню Design > Fabric Settings 
(проект > установить ткань). 

 

 
 
• Нажмите Shift+R для просмотра стежков. 

Можно будет увидеть, как будет выглядкть 
проект, вышитый на машинеe. 

 

 
• Отправьте проект на машину напрямую или 

через промежуточный носитель (обычно 
через накопитель USB). 

Что делать после переноса проекта на машину – 
описано в документации вашей машины 
BERNINA. 
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Изменить исходный образец 
 
После того, как Вы освоите вышивку клипартов и 
других образцов, можно переходить к их 
изменению – изменить размер, цвет нити и тип 
ткани. Это простые и схожие операции.  
 
Изменить исходный образец 
 
• Откройте нужный проект и выберите его 

щелчком. 

 
• Проверьте размеры и поменяйте, если 

нужно.  
Например, если Вы вышиваете проект на 
левую часть груди, его размер не должен 
превышать примерно 4.25 дюйма (108 мм). 

 

• Выберите желаемый цвет нити.  
 
• Выберите и измените тип ткани с помощю 

комманды меню Design > Fabric Settings . 

 
• Выберите пяльцы нужного размера. 
• С помощью команды меню Design > 

Background можно визуализировать 
вышивку на одежду или изделие.  

 
• Отправьте проект на машину напрямую или 

через промежуточный носитель (обычно 
через накопитель USB). 

 
Создать простую буквенную 
вышивку 
 
После того, как Вы освоились с изменением 
образцов, можно переходить к созданию 
собственных буквенных проектов. Этот процесс 
не сложнее набора текста на экране ПО 
BERNINA Embroidery Software, хотя и требует 
некоторой практики в получении качественной 
вышивки.  
 
Создать простую буквенную вышивку 
• Чаще всего нужно добавить буквы к уже 

готовому проекту.  
 
• Быстро и легко добавьте буквы на экран 

через текущие настройки или свойства 
элемента.  

 

 
 
• Правым щелчком мыши на инструмент 

можно изменить текущие настройки.  
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• Попробуйте вышить проект. Проверьте 

качество стежков. Имейте ввиду, что разные 
алфавиты лучше вышивать разным 
размером.  

 
Монограммы  
 
BERNINA Embroidery Software делает создание 
монограмм достаточно простым с инструментом 
Monogramming tool «все в одном», который 
размещен под инструментом Lettering tool. 
Дополнительно можно включить в монограмму 
орнаменты, буквы и/или до 4 концентрических 
границ. 

 
Создать вышивку автоматически 
 
Хорошо, если Вы продвинулись уже достаточно 
далеко в изучении возможностей машины 
BERNINA и ПО BERNINA Embroidery Software. 
Вы уже можете многого достичь, даже не 
создавая собственные проекты и не 
оцифровывая их. Тем не менее, возможно 
именно этого Вам хочется! 
Самый быстрый способ – использовать 
автоматические технологии ПО BERNINA 
Embroidery Software. И хотя этот способ 
несколько ограничен в своих возможностях, он 
позволяет создать прототипы проектов просто, и 

вполне достаточен на данном этапе.  
 
Преобразование вектора картинки 
Специальные инструменты ПО BERNINA 
Embroidery Software автоматически 
конвертируют векторные объекты и текст в 
вышивку или текстовый проект. Их уже можно 
при необходимости изменять.  

 
 
Совет Начните с клипартов CorelDRAW

®

. Многие 
из них могут быть использованы как вышивка.  
Преобразование рисунка с носителя  
 
Инструмент Magic Wand (волшебная палочка) 
автоматически конвертирует рисунок с 
цифрового носителя. Расширение этой 
технологии, Auto Digitizer (автодигитайзер), 
распознает формы и определяет наиболее 
подходящий тип стежка.  
 

 
Подсказка: Изучите образцы проектов, 
поставляемых в составе ПО BERNINA 
Embroidery Software. Попробуйте вышить такой 
проект. Это поможет лучше понять, какие 
техники используются, а также то, какие имеются 
ограничения. 
 
Следующие шаги 
К этому моменту Вы уже овладели 90%  техник, 
применяемых большинством мастеров 
вышивания. 
Следующий шаг к мастерству – освоение 
«черного шитья» и ручной оцифровки. Но не 
надо сразу «погружаться» слишком глубоко. 
Можно начать с достаточно простых проектов  
постепенно усложнять их разными сложными 
стежками. См. «Справочник» и другие он-
лайновые ресурсы. 
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Специальные эффекты вышивания 
Освоив ручную оцифровку, вы можете 
использовать весь спектр типов стежков и 
разных эффектов, предлагаемых ПО BERNINA 
Embroidery Software. Со многими из них Вы 
познакомитесь, приспосабливая имеющиеся 
проекты под разные цели. 
 

 
Некоторые из многих техник, поддерживаемых 
ПО BERNINA Embroidery Software, перечислены 
ниже: 
• Иммитация вышивки вручную 
• Образцы стежков,штампов и заполнений 
• Контура и заполнения художественными 

стежками 
• Аппликации 
• Стежки «крестиком» 
• Пуговичные петли 
• Мульти-украшения 
• Квилтинг 
• Рельефгые вышивки 
 
См. «Справочник» и другие он-лайновые 
ресурсы. 

 
Приятной работы!  
 
Приятной работы с машиной BERNINA  и ПО 
BERNINA Embroidery Software. С нашим 
оборудованием у Вас есть все необходимое для 
создания полностью профессиональной и 
высококачественной вышивки. Единственное, 
чего Вам теперь не хватает – мощностей для 
массового производства!  
 
Не забывайте использовать встроенные проекты 
и клипарты. Если сомневаетесь, вернитесь к 
самому началу. А когда захотите 
усовершенствовать и расширить свой репертуар, 
тщательно изучите то, как сделаны встроенные 
образцы.  
 
Всего наилучшего. Приятной работы!
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Краткий справочник по вышивальному программному обеспечению  
BERNINA Embroidery Software 
 
Программа BERNINA Embroidery Software 
интегрируется с программой CorelDRAW® Essentials 
Х6 , образуя единое приложение.  В этом 
справочнике перечислены функции и инструменты, 
имеющиеся в режимах  Embroidery Canvas и Hoop 
Canvas. Не все функции, перечисленные здесь, 
доступны на некоторых уровнях программного 
продукта. См. Список функций программного 
продукта в Инструкции пользователя.  
 
 
Ппанель инструментов Embroidery 
Canvas 
 
Рабочее пространство Embroidery Canvas 
содержит панели инструментов, описанные ниже. 
Не все инструменты доступны на разных уровнях 
продукта. 
 
Панель инструментов Canvas toolbar 
В ПО BERNINA Embroidery Software имеются три 
режима работы, в которые можно войти через  
Canvas toolbar. 
 

 

Загружайте, редактируйте, сохраняйте в 
качестве фона для оцифровки вышивок 
любую графику – в ручном режиме или 
автоматически. 
 

 
Режим позволяет оцифровывать и 
редактировать образцы вышивки. 
Показывает как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать образцы 
реалистически в трехмерной графике 3D.
 

 
Позволяет просматривать и 
редактировать проекты, не 
помещающиеся в пяльцах. Если ваша 
вышивка слишком велика, или содержит 
много образцов, расположенных на 
пространстве, разбитом для вышивки на 
многих пяльцах. 

 
Show Embroidery для 
включения/выключения дисплея 
вышивок. 

 
Преобразовать вышивку в рисунок: 
Преобразовать выбранные объекты 
вышивки в векторный рисунок. 
 

 

Преобразовать рисунок в вышивку. 
Преобразовать выбранные векторные или 
побитовые рисунки в стежки контуров и 
заполнений 
 

 
ВНИМАНИЕ: Полное описание инструментария 
программы CorelDRAW® Essentials X6 приводится в 
электронном Руководстве пользователя, которое 
можно найти в разделе меню Windows Start > 
Programs. Можно использовать экранную систему 
помощи с помощью меню Help в режиме Graphics. 
 
Общая панель инструментов  
Эта панель содержит инструменты, позволяющие 
открывать и выводить проекты, получать доступ к 

свойствам проекта, открывать и закрывать окна 
докеров.  
 

 

 
Открыть новый пустой проект   
 
Открыть проект.  
 
 
Сохранить текущий проект  
 
Печать проекта с текущими 
настройками печати 
Просмотр проекта с возможностью 
распечатки. 
 
Сохранить проект на карту 
BERNINA design card или на 
вышивальную машину BERNINA . 
То же, что Edit > Cut. 
 
 
То же, что Edit > Copy. 

То же, что Edit > Paste. 
 
 
То же, что Edit > Undo. 
 
 
То же, что Edit > Redo. 
 
 
 
То же, что File > Insert Embroidery. 
 
 
 
То же, что File > Insert Artwork 
 
Доступ к вспомогательным 
программам  – Portfolio, Cross 
Stitch, и Quilter. 
 
Доступ к свойствам выбранного 
объекта, или  предварительная 
настройка свойств без выбора 
объекта. 
Применение эффектов к 
выбранному объекту, или  
предварительная настройка 
эффектов без выбора объекта. 
Доступ к опциям рабочего 
пространства (сетка, пяльцы, 
настройка скроллинга). 
 
Изменение единиц измерения в 
программе, а не в настройках ОС. 
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Показать или скрыть окно обзора. 
Можно увеличить иконку текущего 
проекта 
 
Показать или скрыть докер Color 
Film. Можно изменить 
последовательность объектов и 
цветовых блоков в проекте. 
Показать или скрыть докер Carving 
Stamp. Можно использовать 
образцы для создания примера 
прокола иглы.   
 

Показать или скрыть докер 
Morphing Effect .Можно изменять 
форму объектов, контуров и 
заполнений. 
 

Показать или скрыть докер 
StumpWork Border. Используется 
вместе с инструментами 
StumpWork toolbox. 

Панель инструментов просмотра 
View 
Эта панель содержит разные инструменты 
визуализации проекта. См. раздел Просмотр 
проектов в Справочнике. 

 

 

Показать или скрыть иммитацию 
готовой вышивки. 
 
Сделать фон бледнее, для более 
четкого просмотра стежков при 
оцифровке. 
 
Показать или скрыть стежки. 
 

 

Показать или скрыть точки 
проколов иглы на вышивке. 
 
Показать или скрыть 
соединительные стежки между 
объектами вышивки. 
Показать или скрыть любые 
побитовые рисунки в составе 
проекта. 
Показать или скрыть любые 
векторные рисунки в составе 
проекта, например CorelDRAW® 
clipart 
Показать или скрыть любые 
подпроекты stumpwork в составе 
проекта. 
Показать или скрыть фоновые 
ткани/цвета.любого объекта 
аппликации в проекте 
Показать или скрыть пяльцы. 
Правой клавишей мыши – доступ к 
свойствам. 
Показать или скрыть сетку 
рабочего пространства. Правой 
клавишей мыши – доступ к 
свойствам. 
Показать или скрыть линейки 
рабочего пространства. Правой 
клавишей мыши – доступ к 
свойствам. 
Иммитация процесса вышивки на 
экране в режиме просмотра 
стежков или в художественном 
режиме. 
 

Палитра оттенков 
Эта панель отображает палитру оттенков ниток, а 
также инструменты для выбора, применения и 
циклического просмотра оттенков. См. Оттенки и 
таблицы ниток в Справочнике. 

Скопировать оттенок 
существующего объекта для 
использования. 
 
Применить выбранный оттенок к 
объектам вышивки. 
 
Показать текущий выбранный 
оттенок палитры 
 
Просмотр комбинаций выбранных 
оттенков, щелчками слева и 
справа. 
Функция Color Wheel для 
просмотра разных комбинаций 
оттенков. 
Поиск и подбор оттенков ниток из 
разных наборов. Выбор ниток для 
использования. 
 

 
Панель стежков (Stitch toolbar) 
 
Эта панель содержит наборы контурных и 
заполняющих стежков, а также художественные и 
декоративные стежки. Там же есть доступ к разным 
эффектам, которые можно дополнительно 
применить к стежкам. Тип стежка можно выбрать, 
щелкнуа по иконке левой клавишей мыши. Правая 
клавиша дает доступ к свойствам стежков. См. 
раздел Контурные и заполняющие стежки в 
Справочнике. 

Контурные стежки 
 

Создать одиночный ряд стежков 
вдоль оцифрованного контура – 
используется для границ или 
деталей. 
Утолщенный контур с повторением 
стежков по три раза.  Используется 
для утолщенных границ и деталей. 
 
Классический контур обратными 
стежками- старый тип стежка, 
применяемый для деликатных 
контуров 
Создать границу или деталь с 
помощью стежков типа stemstitch. 
 
Гладьевый контур – для утолщенных 
контуров или ровных столбцов 
 
Рельефный гладьевый контур – 
используется для эффектов типа 
квилтинга 
 
Создание длинных узких границ с 
эффектом ‘comb’ . 
 
Контур из художественных 
орнаментных стежков. Название 
происходит от традиционной техники 
вышивания черным шелком. 
 
Контур из художественных 
орнаментных стежков.. Можно 
указать точные размеры образца и 
интервалы. 
 
Контур из художественных 
орнаментных стежков. Можно 
выбрать из библиотеки образцов 
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Заполнения 
 

 

Стежки заполнения для крупных, 
нерегулярных фигур. 
 
Гладьевые стежки заполнения для 
узких фигур. 
Рельефное заполнение гладью – 
можно использовать для букв или 
для создания эффекта квилтинга.. 
 
Художественное заполнение, 
выглядещее как солидные стежки . 
 
Эффект 3D с возвратными стежками 
заполнения. 
 
Спиральные стежки от середины 
любого объекта. 
 
Стежки, следующие вдоль контура, 
создавая искривленный эффект сета 
и тени. 
 

 

Заполнение для проектов, 
выполняемых черными нитками. . 
Название происходит от 
традиционной техники вышивания 
черным шелком. 
 
Заполнение «свечками» - для 
традиционной вышивки толстыми 
белыми хлопковыми нитками по 
белому льну. 
 
Заполнение с эффектом глянца. 
 
Декоративные стежки заполнения.. 
Выбор из библиотеки образцов. 
 
Открытое заполнение крестиками, 
генерируемыми так, чтобы 
соответствовать стандартной сетке 
для всего проекта. 
 
Заполнение строчными стежками, 
сгущающимися у границы. 
 
Уплотненное заполнение строчными 
стежками. 
 
Уплотненное заполнение строчными 
стежками  и контур обратными 
стежками.  

Эффекты (Effects) 

 

Стабилизировать объект 
подлежащими стежками. 
 

 

Создать грубые края, эффект тени. 
Иммитировать грубую текстуру. 
 
Создать стежки имеющегося типа, 
поворачивающиеся по кругу. Стежки 
создаются от переферии к центру. 
Центр можно сдвинуть. 
 
Создать контурные стежки вдоль 
оцифрованной направляющей 
линии. Поддерживается 
равномерная плотность стежков. 
 

Панель инструменов преобразований 
Эта панель, содержит инструменты, нужные для 
выбора, преобразования, масштабирования и 
отражения объектов вышивки в режиме Embroidery 

Canvas. См. раздел  Организация и преобразование 
объектовs в Справочнике. 

 
Кликнуть для выбора объекта 
 
. 
 
Выбор фигур или объектов – с 
помощью контрольных точек можно 
установить границу. 
 
Переформировать выбранный 
объект или вышивку. 
 
 
Увеличить/уменьшить размер 
выделенного объекта шагами по 
20%. Автоматически 
пересчитываются стежки. 
 

 
Отразить объект относительно 
горизонтали или вертикали.  
 
 
 
 
 
 
 
Повернуть выделенные объекты 
щагами по 45° влево или вправоt. 
 
 
Поовернуть выбранный объект на 
указанный угол в градусах – 
положительный или отрицательный. 
 
Наклонить выбранный объект на 
указанный угол в градусах – 
положительный или отрицательный. 
 
Точные настройки положения 
выбранного объекта. Используется 
вместе линейками и направляющими 
линиями. 
 

 
Масштабирование объекта 
или всего проекта с 
указанием точных 
размеров по вертикали и 
горизонтали, либо с 
указанием процента 
увеличения/уменьшения. 
Для сохранения пропорций 
можно использовать 
функцию Aspect Ratio.. 
 

Панель Zoom 
Панель содержит инструменты изменения 
масштаба просмотра объектов. Аналогичные 
функции имеются в меню View. См. Раздел  
Zooming & panning (масштаб просмотра) в 
Справочнике. 

www.promelectroavtomat.ru



Краткое справочное руководство 
 

BERNINA® Вышивальное ПО – QSG 12

 

Левый щелчок – приближение (zoom 
in), правый – удаление (zoom out), 
или потянуть  ‘zoom box’. 
Можно также использовать «горячую 
клавишу» <B> . 
 
Zoom Factor: выбор точной степери 
приюлижения/удаления в 
процентах.из выпадающего списка. 
Нажав клавишу <F> можно указать 
любой процент. См. Также раздел 
Панель Zoom . 
 
 
 
 
 
 
Потяните для панаромирования 
проекта при высоких значениях  
zoom factor. Можно также 
использовать «горячую клавишу»  
<P>. 
 

Панель инструментов Embroidery 
Canvas  
Рабочее пространство Embroidery Canvas имеет 
панель инструсентов, перманентно закрепленную в 
левой части экрана. Панель содержит набор 
выпадающих списков, содержащих наборы 
инструментов, организованных следующим 
образом. 
Инструменты редактирования (Edit) 
Этот набор содержит все инструменты, нужные для 
редактирования вышивок в режиме Embroidery 
Canvas. 

 

 

Добавить глазки в заполненных 
объектах. 
 
 
Удалить глазки с выбранных 
объектов 
 
Добавить углы шитья для замкнутых 
объектов с петлями и без. Правый 
щелчок мышью - настройки. 
 
Удалить углы для замкнутых 
объектов. 
 
 
Усилить контур, прощив его в 
обратном направлении. 
 
 
Автоматический выбор наиболее 
эффективного  контура . 
 
Стежки смешанными цветами в 
замкнутых объектах 
 
Заполнение глазков в выбранном 
объекте текущим типом стежков. 
 

Автоматически окружить контуром 
выбранный объект тройной или 
гладьевой линией. 
 
Вместе с рельефной гладью создает 
эффект квилтинга. 
 
Разбиение монограм, апликаций, 
текстов и «серных вышивок» на 
составляющии объекты для 
редактирования. 
 
Удаление ненужных нижних слоев и 
текстов. 
 
Удаление ненужных стежков из 
нижних слоев аппликаций. 
 
 
Помещение курсора в нужную 
позицию 
 

 
Инструментарий автоматической оцифровки 
Имеются все инструменты, необходимые для 
автоматической оцифровки рисунков в режиме 
Embroidery Canvas. См. раздел  
Автоматическая оцифровка  в Справочнике. 

 

 

Автоматическая оцифровка 
подготовленного побитового рисунка.
 

Автоматическая оцифровка зоны 
хаполнений в векторных или 
побитовых рисунках. 
 
Преобразование черно-белых и 
цветных фотографий в вышивки. 
 

Инструментарий оцифровки 
Этот набор содержит все инструменты, нужные для 
ручной оцифровки проектов вышивок в режиме  
Embroidery Canvas. Правый щелчок мыши – доступ 
к свойствам. См. раздел Методы оцифровки  в 
Справочнике.. 

 
 
Оцифровать незамкнутые объекты 
вышивки. 
 
Оцифровать замкнутые объекты 
вышивки. 
 
Нарисовать контур прямо на экране 
для текущего типа стежков. 
 
Нарисовать замкнутый объект прямо 
на экране для текущего типа 
стежков.- контурных и заполнений 
 
Оцифровка колонок с 
поворачивабщимися стежками. 
 
 
Оцифровка круговых и элиптических 
объектов. 
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Оцифровка квадратных и 
прямоугольных объектов. Для 
сжатия нажмите <Ctrl>. 
 
Созжание текстовых вышивок прямо 
на экране. 
 
 
Создание своих монограмм с 
возможностью выбрать стиль, форму 
границы и орнаменты. 
 
 
Оцифровка заскнутых объектов 
аппликаций со стежками. 
 
Создание незамкнутых аппликаций 
из одного или нескольких исходных 
объектов 
 
Оцифровка одной пуговичной петли 
со всеми нужными стежками. 
 
Оцифровка ряда пуговичных петель 
со всеми нужными стежками. 
 
Оцифровка проектов PunchWork для 
работы с инструментом BERNINA 
Rotary Hook Punch tool. 
 
 
Вставка отдельных образцов в 
проект. Выбор из библиотеки 
проектов. 
 

Панель настройки «ручного» вышивания 
(Freehand Setting) 
Когда включаются инструменты свободного 
вышивания Freehand, появляется  панель Freehand 
Settings. 

 

 

Функция Show Guide (указать 
направляющие). Для работы с курсором 
оцифровки свободной вышивки. Это 
удобнее, чем обычный курсор. 
 
Управление контролем внутреннего 
радиуса. Определяет размер 
центрадьного круга направляющей 
оцифровки свободной  вышивки.  
 
 
Число направляющих кругов для 
курсора свободной вышивки.  Если 
внутренний круг имеет радиус 2мм, 
каждый следующий будет иметь отступ 
в 2мм. 
 

 

Используйте управление 
сглаживанием. Определите в 
процентах, как близко 
сглаженный контур следует за 
оригинальным. 
 

Набор инструментов StumpWork 
Набор инструментов StumpWork содержится в  
Toolbox. Он содержит все инструменты, нужные 
для оцифровки проектов  stumpwork «с нуля», или 
для создания проекта stumpwork из имеющихся 
объектов. См. также Stumpwork - вышивки 
embroidery в Справочнике.l. 

 
 

Создание границы stumpwork из 
выбранных объектов. 
 
Оцифровка незамкнутой границы 
stumpwork, используя оцифрованный 
контур и текущие настройки. 
 
Оцифровка замкнутой границы 
stumpwork, используя оцифрованный 
контур и текущие настройки. 
Вырезать по замкнутой границе 
stumpwork.Оставить отверстие – 
например, для концов проволоки. 
Создать линию проволоки (wireline) , 
используя оцифрованный контур и 
текущие настройки. 
Создать под-проект stumpwork из 
выбранных объектов, включающих 
вышивку внутри границ stumpwork. 
 
Просмотр и редактирование 
выбранного под-проекта stumpwork 
 
Сохранить под-проект stumpwork 
отдельным файлом. 
 

Инструменты отражения и слияния 
Этот набор содержит все инструменты, нужные для 
копирования и преобразования выбранных 
объектов вышивки в вертикальной и горизонтальной 
плоскостях. См. также Отражение объектов в 
Спаравочнике 

Копировать и отразить горизонтально. 
Опция – слить перекрывающиеся 
объекты 
Копировать и отразить вертикально. 
Опция – слить перекрывающиеся 
объекты 
 
Копировать и отразить выбранные 
объекты вокруг центральной точки. 
Копировать выбранные объекты вокруг 
центральной оси. Укажите дубликаты в 
настройках панели отражения и 
слияния. 
Копировать и отразить выбранные 
объекты вокруг центральной оси. 
Укажите дубликаты в настройках 
панели отражения и слияния. 
 
Указать число точек копирования. Для 
калейдоскопа – число должно быть 
четным. 
 

Инструментарий выравнивания 
Этот набор содержит все инструменты, нужные для 
точного выравнивания, распределния и отражения 
объектов в режиме Embroidery Canvas. См. такжеo 
Выравнивание и преобразование объектов в 
Справочнике. 
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Группирование нескольких объектов в 
один 
Разгруппирование группы на отдельные 
объекты. 
 
Защитить выбранные объекты 
 
 
Снять зщиту всех объектов. 
 
Выравнивание выбранных объектов по 
левому краю. 
 
Вертикальное выравнивание центров 
выбранных объектов. 
 
Выравнивание выбранных объектов по 
правому краю. 
 
Выравнивание выбранных объектов по 
верхнему краю. 
 
Горизонтальное выравнивание центров 
выбранных объектов. 
 
Выравнивание выбранных объектов по 
нижнему краю. 
 

 

Выравнивание центров выбранных 
объектов. 
 
Равномерно разместить три и более 
объектов по горизонтали. 
 
Равномерно разместить три и более 
объектов по вертикали. 
 

Панель инструментов Color Film 
Эта панель доступна в режиме Embroidery Canvas. 

 

 

Показать отдельные объекты в порядке 
вышивания. Изменить порядок можно 
перетаскивая иконки объектов. 
 
Сдвинуть выбор объекта на соседний 
(вперед/назад). 
 
 
Сдвинуть выбор цвета на соседний в 
последовательности (вперед/назад). 
 
. 
 
 
 
Сдвинуть выбор на начальный / 
конечный объект. 
 

 

Изменить последовательность 
объектов в порядке выбора 
 
Ихменить последовательность 
цветовых блоков. (для работы с 
отдельными блоками используйте 
Color Film.) 
 

 

Панель инструментов пялец (Multi-
Hooping toolbar) 
Эта панель появляется в режиме Hoop Canvas См. 
Заправка проектов в пяльцы в Справочнике. 

 
Добавить еще одни пяльцы к проекту с 
многими заправками. 
 
Поместить новые пяльцы справа от 
выбранных. Позволяется перекрытие в 
10 мм между полями шитья 
 
Поместить новые пяльцы сверху от 
выбранных. Позволяется перекрытие в 
10 мм между полями шитья. 
 
 
Добавляются 4/8 пялец по периметру 
выбранных. Позволяется перекрытие в 
10 мм между полями шитья..  
 
Оцифровать одну или более 
направляющих для разделения 
объектов между пяльцами. 
 
Удалить выбранные пяльцы из проекта 
 
 
Рассчитать число заправок в пяльцы, 
исходя из данного проекта. 
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